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Whether youre trying to organize your files, share important paperwork online, or youre just sick of paper piles, converting your scanned documents into PDFs makes them easier to store, use, and share. In this article, well walk through a few simple ways to convert your scanned files to PDF using both free tools and paid software. No tech degree
requiredjust a few clicks and youre good to go. When it comes to saving and sharing scanned documents, PDF is one of the easiest and most reliable formats you can use. Its been around since the early 1990s and has become the go-to standard for good reason. PDFs work on just about any device, and they keep your formatting exactly the way you
want it, no matter what platform or operating system someones using. Thats actually where the name comes from (PDF stands for Portable Document Format). They can also be compressed without sacrificing quality, which makes them smaller to store and faster to download. If youre working with sensitive information, the PDF format includes
security features like password protection, encryption, and digital signatures to help you keep your data secure. You can also edit PDFs, add in images or links, and customize them as needed. All of this makes PDF a solid choice, whether youre scanning documents for personal use or managing files for work. There are tons of tools out there that can
help you convert scanned documents to PDF, so the best one for you really depends on what you need to do. If youre just looking to scan and save the occasional document here or there, one of the free tools below should me more than enough to get the job done. If youre handling a larger volume of documents or need extra features like OCR, batch
processing, or tighter security, it might be worth investing in a paid option. Heres a quick breakdown of both free and paid tools to help you find the right fit. Great for personal use or small businesses with basic scanning and conversion needs. Most of these come with simple features like scan-to-PDF, light editing, and file merging. NAPS2 (Not
Another PDF Scanner 2): A lightweight, open-source tool with a clean interface and support for both TWAIN and WIA drivers, which means it works with most scanners. You can set up scanning profiles, reorder pages, and apply OCR if needed. Its great if you want something fast and customizable without bloat. PDF24 Creator: A full-featured PDF
utility that goes beyond basic scanning. It lets you merge, split, compress, and even annotate PDFs. It also includes a virtual printer, so you can convert almost any file to PDF simply by printing to PDF. Its perfect for users looking for a little more without a steep price tag. Scan2PDF: Super straightforward and focused entirely on one task, turning
paper documents into PDF format fast. There arent many extra features, but if all you want to do is scan and save, it gets the job done without any unnecessary distractions. PaperScan Free Edition: Offers a little more control during scanning, including image enhancement tools like de-skew, rotation, and color adjustment. Its useful if your scans tend
to need a little cleanup before saving. Paid software is a better fit for businesses or power users who need more control over their documents. These tools often include features like batch processing, advanced OCR, better security options, and tighter integration with other apps. If youre managing large volumes of files or need to keep everything
searchable and secure, a paid option may be worth the investment. Adobe Acrobat Pro: One of the most well-known PDF tools out there, Acrobat Pro does it allOCR, advanced editing, batch processing, form creation, digital signatures, and more. Its especially useful if your team collaborates on documents or if you work in a regulated industry where
document security and audit trails matter. ABBYY FineReader: Best known for its highly accurate OCR, FineReader is ideal for converting scanned documents into fully searchable and editable PDFs. It supports a wide range of languages and has strong tools for comparing document versions and automating data extraction. A solid pick for legal,
academic, or enterprise-level work. Kofax Power PDF: Offers many of the same features as Acrobat but with a one-time purchase instead of a subscription. It includes form building, secure file sharing, editing, and conversion tools. Its a good fit for professionals or businesses that want powerful features without suffering through yet another software
subscription. Nitro Pro: Known for being user-friendly, Nitro Pro makes PDF editing and document conversion feel more intuitive. It supports electronic signatures, batch OCR, and integrates well with cloud services. Great for teams that want to streamline their document workflows without a steep learning curve. OCR, or Optical Character
Recognition, helps you turn the text contained in your scanned images into actual searchable and editable text. Whether or not you need it really depends on what you plan to do with your PDFs after theyre created. If you want to edit the text in a scanned document instead of just looking at it. If you need to search through lots of PDFs and find
specific words or phrases quickly. If youre pulling data from forms or invoices, OCR can help you extract that information without retyping it.If youre just archiving documents and dont plan to search or edit them. If the file is mostly images, like a scanned photo album or a visual report, and you dont need to interact with the text. So, if your main goal
is simply to save and store your documents, you can skip OCR. But if youre looking for better searchability or need to work with the text, its worth looking for software that includes OCR. Converting paper documents into PDFs is usually pretty simple, especially with the right software. In the sections below, well walk through the steps for using a few
different software options, both free and paid, so you can scan your documents and save them as PDFs. Whether youre working with just a few pages or scanning files in bulk, these instructions will help you get the job done quickly. Open the Image in Photoshop:Start by opening Adobe Photoshop. Click on File in the menu bar, then select Open...
Browse to the location of the image you want to convert and open it. Make Necessary Edits (Optional):Before converting your file, you can edit the image as needed. This might include cropping, adjusting colors, or even applying filters. Once you are satisfied with the image, proceed to the next step. Convert to PDF:Go to File in the menu bar. Choose
Save As... or Save a Copy... (depending on your Photoshop version). In the Save As dialog box, select the location where you want to save the file. In the Format dropdown menu, select Photoshop PDF. Configure PDF Settings:Once you select Photoshop PDF, a new dialog box will appear with a few PDF options. You can choose from various presets
depending on your needs. For instance, High Quality Print is suitable for printing, while Smallest File Size is better for online use. Adjust the settings as necessary. If youre not sure, the default settings are usually a good starting point for most. Save the PDF:Click Save after adjusting your settings. You might see another dialog box with more options.
Review these and make changes if needed. For simple conversions, the default settings are typically fine. Click Save PDF. Review the PDF:After saving, its a good idea to open the PDF to ensure it looks as expected. You can open it in a PDF viewer like Adobe Acrobat or your web browser.Open Adobe Acrobat:If you dont have Acrobat, you can
download a trial from Adobes official website and choose the version that fits your needs. Create a New PDF:In Adobe Acrobat, go to the File menu in the top-left corner. Select Create and then choose PDF from File.... This will open a file selection dialog. Select Your Image:In the dialog box, navigate to the folder where your image is stored. Select
the image file you wish to convert. Acrobat supports various image formats like JPG, PNG, BMP, GIF, and TIFF. Click Open to import the image into Acrobat. Image to PDF Conversion:Once you select the image, Acrobat will automatically convert it into a PDF. The conversion process usually takes just a few seconds. Edit the PDF (Optional):After
conversion, you can use Acrobats editing tools to make changes to the PDF if necessary. This could include adding text, annotations, or combining multiple images into one PDF. To edit, use the tools available in the right-hand pane or under the Tools tab. Save the PDF:Once youre satisfied with the document, go to File > Save As. Choose a
destination for your PDF and enter a file name. Click Save. Review the PDF:After saving, its a good practice to open the PDF to ensure everything looks as expected. You can view it in Acrobat or any other PDF reader.Open ABBYY FineReader: Open the Image File:Click on File in the top menu. Choose Open or Open Image. Browse to the location of
the image file you want to convert and select it. ABBYY FineReader supports various image formats like JPG, PNG, BMP, and TIFF. Recognize the Text (Optional):If your image contains text and you want to use FineReaders OCR feature, click on the Recognize button. This will convert any text in the image into editable and searchable content in the
PDF. You can choose the language of the text for better accuracy in recognition. Edit and Arrange the Document (Optional):Before converting, you have the option to edit the document. This might include adjusting layout, correcting OCR errors, or editing the text directly in FineReader. You can also rearrange pages or add pages from other files if
needed. Save as PDF:Once you are ready to convert, go to File > Save As. In the Save As dialog, choose PDF Document as the format. Choose your desired PDF settings. FineReader offers various options, like saving as an image-only PDF or a searchable PDF with editable text. Finalize the Conversion:Select the location where you want to save the
new PDF. Click Save to complete the conversion. Review Your PDF:After conversion, its a good idea to open the PDF to ensure it has been converted as expected. Check the quality of the OCR if you used that feature.Install PDF24 Creator:If you havent already installed PDF24 Creator, download it from the official PDF24 website and follow the
installation instructions. Launch PDF24 Creator:Open PDF24 Creator on your computer. Import Your Image:You can import your image file in a couple of ways:Drag and drop the image file directly into the PDF24 Creator interface. Alternatively, click on the File menu, select Import from file..., and then navigate to and open your image file. Image File
in PDF24 Creator:Once the image file is imported, it will appear in the PDF24 Creator interface as a new project. Edit the Image (Optional):If you need to make any adjustments to the image before converting it to PDF, you can use the editing tools provided in PDF24 Creator. This might include cropping, rotating, or rearranging the page order if
youre converting multiple images. Convert to PDF:Click on the Save as PDF icon or button. This will convert the image to PDF format. You can also choose the Merge function if you have multiple images and you want to combine them into a single PDF. Save the PDF:A window will pop up asking you to choose a destination to save the PDF file. Name
your file and choose where you want to save it on your computer. Click Save. Review Your PDF:After saving the file, open the PDF to ensure it looks as expected. Verify that all the images are correctly formatted and that the quality is satisfactory. Adobe also offers an online document to pdf converter. To convert an image to a PDF using Adobes free
online PDF converter, you can follow these steps: Go to Adobes PDF Converter: Upload Your Image:Look for an option to upload or drag and drop your image file. The online tool typically supports various image formats like JPG, PNG, BMP, etc. Convert the Image:After uploading the image, the tool will give you options or settings for the conversion
process. Adjust these as needed. Download the PDF:Once the image is converted, you should have the option to download the new PDF file to your computer. Review the PDF:Check the downloaded PDF to ensure the conversion went smoothly and the image quality is preserved.. This online tool is handy for quick conversions without the need for
downloading or installing any software. For businesses with a substantial volume of documents to convert to PDF, outsourcing this task can be immensely beneficial. At SecureScan, we specialize in handling large-scale scanning projects efficiently and accurately. Our expertise ensures high-quality results, while our advanced equipment processes
documents rapidly, making the entire process cost-effective for your business. By delegating this task to us, your team can focus on core business activities, confident in the knowledge that your document conversion is in expert hands. We prioritize security and compliance, ensuring your data is handled with the utmost care. Opting for our service not
only streamlines your document management process but also enhances your overall operational efficiency. For more information, contact us or get a free quote for your next scanning project from one of our scanning technicians. Get in touch with SecureScan We're here to help you tackle your paper problems. Contact us for more information, and
someone will get back to you as soon as possible. Speak With Us Learn More About Our Services SecureScan offers convenient and secure document scanning services to help you modernize your business's paper processing workflows. Scan and Shred Want to scan a document and save it as a PDF file on Windows 10/11? Dont want to use third-party
programs to save scanned pictures or documents as PDF? In this guide, we will see how to automatically save scanned files as PDF with ease.As with the case of its predecessors, Windows 10/11 also has a built-in Fax and Scan program using which one can use scan files by connecting Windows 10/11 PC to a scanner.The built-in Windows Fax and
Scan program is a legacy desktop program but does its job well. The only problem with Windows Fax and Scan is that it cannot save scanned files in PDF or portable document format default. But there is a workaround to save files as PDF after scanning documents and pictures using Windows Fax and Scan program. Additionally, you can also use the
new Windows Scan app from Microsoft to automatically save scanned documents and pictures as PDF. In addition to PDF, the Windows Scan app enables you to save scanned files in JPEG, PNG, TIFF, Bitmap, OpenXPS, and XPS formats.In this guide, we will see how to use Windows Fax and Scan and Windows Scan to save scanned documents and
pictures as PDF.Method 1 of 2Save scanned files as PDF using Windows Fax & ScanlIf you are using the Scan app, please refer to the directions in Method 2 (scroll down to see).Step 1: Open Windows Fax and Scan program. Click the New Scan button in the toolbar.NOTE: If Windows Fax and Scan app is missing from your PC, please use the official
Scan app as mentioned in Method 2 (scroll down to see). Step 2: View or select a different scanner by clicking the Change button in the Scanner section.Step 3: In the Profile section, select the type of file that you are going to scan as either Photo or Document. Change other default settings, if you want.Step 4: Click the Scan button to begin scanning
the hard copy in the scanner.Step 5: Once the scanning is completed, click the File menu and then click the Print option. Yes, we are going to save the file as PDF.Step 5: When the Print dialog shows up, select Microsoft Print to PDF from the printer drop-down box, and then click the Print button.Step 6: At the Save Print Output As dialog, enter a
name for your scanned file, select a location to save the file, and then click the Save button to save it as PDF file. Thats it!Method 2 of 2Save scanned files as PDF using Windows Scan appHere is how to use the Windows Scan app to save scanned files in PDF on Windows 10/11/Step 1: Check if the Windows Scan app is already installed on your
Windows 10/11 PC. If not, visit Windows Scan page in your web browser to automatically open the page in Microsoft Store app. Install the app.Step 2: Turn on the scanner, if not already done.Step 3: Open the Windows Scan app. Note that Windows Scan and Windows Fax and Scan are two different apps. You need to open the Scan app.Step 4: The
Windows Scan app should automatically detect your scanner. If two or more scanners are found, please select the one that you would like to use now.Step 5: In the left pane, just below the scanner now, you can see the file type box. Select the PDF option. If the PDF option is not showing up, change the Source from auto-configured to Flatbed and
then check the file type drop-down to find the PDF option.Step 6: Finally, click the Scan button to begin scanning the paper in the scanner. Note that you can also preview before scanning by clicking the Preview icon.It will also display a small banner once the scanning is completed, with an option to View the scanned file.The Windows Scan app will
automatically save the scanned PDF file in Pictures in the following location by default:C:\Users\YourUserName\Pictures\ScansI hope you find this guide helpful! Download Article Turn a paper document into a PDF file Download Article Scanning documents is easier than everyou can even use your iPhone, iPad, or Android instead of a flatbed scanner
or all-in-one printer! And if you've already scanned your document in a different format, we'll show you how to convert it into an easy-to-send PDF. This wikiHow article will teach you the best ways to scan documents into PDF on any computer, phone, or tablet. On iPhones, open a new note in the Notes app. Tap the camera icon and select Scan
Documents to start scanning documents.On Android, open Google Drive. Click + and select Scan to start scanning documents.On Windows, connect your scanner to your PC. Open Windows Fax and Scan and select New Scan.10pen Notes . It has an icon resembling a notepaper sheet with a yellow top. Tap the icon on your Home screen to open
Notes.Notes comes pre-installed on your iPhone or iPad. If you have deleted the app, you can download it again for free from the App Store. 2Tap the new note icon . It's the icon that resembles a pencil and a sheet of paper. It's in the lower-right corner on iPhone and the upper-right corner on iPad. Advertisement 3Tap the camera icon. It's the icon
that resembles a camera. You can find this above the keyboard. This displays a menu for the camera.[1]4Tap Scan Documents. This is the second option.5Hold your iPhone or iPad over the document. Make sure the entire page is in view of your camera. Hold your iPhone or iPad steady and your iPhone or iPad will automatically take a picture of the
document page. The page will flash yellow when your iPhone or iPad detects the page.For best results, make sure you place the paper of your document on a contrasting surface. Place white paper on a dark surface, or dark paper on a light surface.If you are having problems capturing the document in automatic mode, tap Auto in the upper-right
corner (iPhone), or Manual on the side (iPad) to switch to manual mode. Then tap the large circle button to capture an image of the page manually. Tap and drag the four circles around the page to adjust the white outline. Then, tap Keep scan to save the page.6Repeat for all pages. After scanning the first page of your document, place the next page
on the surface and hold your iPhone or iPad over the second page to automatically scan the next page. Repeat for as many pages are necessary.7Tap the preview image in the lower-left corner. It's the thumbnail image of your most recent scan in the lower-left corner. This displays a preview of all your scans.8Tap a page you want to edit (optional). If
you want to edit a page, tap the page to display a full-screen preview.9Edit the page (optional). Tap one of the options at the top or bottom of the screen to edit the page. The options are as follows:Tap Retake or the plus (+) icon to take another image and replace the scan.Tap the icon that resembles a square with an arrow in the upper-right corner to
rotate the page.Tap the icon with three circles to select a filter for the page.Tap the icon that resembles two angles forming a square to crop the page.Tap the trashcan icon to delete the page.Tap Done when you are done editing the page.10Tap the Share icon . It's the icon that resembles a square with an arrow pointing up. It's in the upper-right
corner. This opens the Share menu.If you are using an iPad, tap the icon with three dots () in the upper-right corner instead. Then tap Send a copy.11Tap Save to Files. This allows you to save the scan as a PDF to your iPhone storage or your iCloud Drive.Alternatively, you can tap Email to email the PDF to someone else.12Select a location to save the
file to. Tap On my iPhone/iPad or iCloud Drive. Then tap a folder you want to save the scan to.13Tap Save. This saves the scan as a PDF to the location you selected. Advertisement 10pen the Google Drive app on your Android device. You'll need to log in to your Google account to use Google Drive.If you aren't already on your Google Drive homepage,
tap Home in the bottom-left corner to do so now.2Tap . It's in the bottom-right corner of the screen. A pop-up menu will open.3Tap Scan. This camera-shaped icon is in the pop-up menu.If you're using the camera for the first time, you may receive a pop-up window. Select either While using the app or Only this time.4Point your phone's camera at a
document. The document should be centered in the middle of the screen.Make sure that your document is flat and completely visible before proceeding.5Tap the "Capture" button. It's a blue-and-white circle at the bottom of the screen. This will scan your document.Select Retry if you want to take the photo again. Otherwise, click OK.Google Drive will
automatically convert your picture into a scan. If there is white space, it will automatically locate the borders of your document.6Tap Save. This is in the bottom-right corner of the screen. This will save your scan.To add more pages to the PDF, tap + and then scan another item.7Save your scanned document onto your phone. Tap the three dots icon in
the top-right corner, then tap Download.To email the scan, tap Send a copy. Advertisement 1Download and install Adobe Scan. Adobe Scan is a mobile app for iPhone, iPad, and Android devices that can be used to scan documents into PDF format using your camera. You can download Adobe Scan for free from the Google Play Store on Android or the
App Store on iPhone and iPad. Use the following steps to download and install Adobe Scan:Open the Google Play Store (Android) or the App Store (iPhone and iPad).Tap the Search tab (iPhone and iPad only).Enter "Adobe Scan" in the search bar.Tap Adobe Scan in the search results.Tap GET or Install next to the Adobe Scan icon.20pen Adobe Scan.
It has a blue icon with the Adobe logo. Tap the icon on your Home screen or Apps menu to open Adobe Scan. Alternatively, you can tap Open in the Google Play Store or App Store once the app is finished downloading.3Sign in to Adobe Scan. You can sign in using your Google account, Facebook account, or Apple ID. Tap Sign in with Google, Sign in
with Facebook, or Sign in with Apple to sign in with your Google, Facebook, or Apple account.Alternatively, if you already have an Adobe ID or want to make one, you can tap, Sign in or sign up at the bottom. Either sign up for a new Adobe ID using your email address or sign in with your existing Adobe ID username and password.4Allow Adobe Scan
to access your camera and send notifications. To do so, tap Allow or Ok when prompted.5Take a picture of the document. To do so, hold your phone or tablet above the document you want to scan and tap the capture button. It's the large circular button at the bottom of the screen.6Tap Keep Scanning. This saves the page you just scanned and allows
you to scan the next page.If you're not happy with how the image looks, you can tap Retake and take the picture again. Alternatively, you can tap and drag the blue circular handles in the corners of the document to adjust the blue outline around the document. Then tap Adjust and save.7Take a picture of the next page. Just like you did with the first
page, hold your phone or tablet over the next page of your document and press the capture button at the bottom of the screen. Repeat for as many pages as your document contains.Retake images or adjust the blue outline around the documents as needed.8Tap the image thumbnail. Once you've taken a picture of your document, you will see a small
thumbnail image of the picture in the lower-right corner. Tap this image to display the scanned document. The scanned document should display just the pages without any of the background or table the document was sitting on.If you want to delete any pages, tap and hold the thumbnail icon to display a thumbnail image of all the pages. Tap the red
"x" icon in the upper-left corner of the image of the page you want to delete, and then tap Delete.9Add a name for the document. To do so, tap the title at the top of the page. Type a name for the document in the first bar of the pop-up. Then tap the blue button that says Rename.10Make any last-minute adjustments. To do so, tap the page you want to
adjust and then use the tools at the bottom of the screen to make adjustments. The adjustment tools are as follows:Tap Add Page to scan another page for your document.Tap Reorder to change the order of the pages. Then tap and drag the pages to change their order.Tap Crop to adjust the page cropping.Tap Rotate to rotate the page.Tap Filers to
change the look of the page. You can select, original color, auto-color, light text, greyscale, or whiteboard.Tap Cleanup and to try to clean up messy looking parts of the document. Then use yoru finger to color over the areas you want to clean up. Then tap the checkmark icon in the upper-right corner.Tap Resize to change the page size. Then select
one of the options at the bottom of the screen.Tap Delete to remove the page.11Tap Save PDF. It's in the upper-right corner. This saves the PDF to your phone or tablet. You can view the document in Adobe Scan, Adobe Acrobat, your web browser, or any other app that can view PDFs.Alternatively, you can save the document as a JPEG image once
you have scanned the document. Tap Save as JPEG once you finish scanning the document to do so. Advertisement 1Connect your scanner to your computer. Depending on your scanner, you can do this via the USB cable, or you can connect wirelessly over your network if your scanner has that feature.Every scanner is different, so consult the
manufacturer's user guide for instructions on how to properly connect your scanner to your computer.2Place your document in the scanner. If you have a flatbed scanner, lift up the lid and place the document face down on the glass top of the scanner. Make sure the document is lined up with any alignment markings on the scanner. If your scanner
has an automatic document feeder, place the document face up in the tray. 30pen Start . Click the Windows logo in the bottom-left corner of the screen.4Type fax and scan into Start. This will search your computer for the Fax and Scan program.5Click Fax and Scan. It's a printer-shaped icon at the top of the Start window. Doing so will open your PC's
Fax and Scan program.6Click New Scan. This button is in the upper-left side of the Fax and Scan window. Clicking it opens a new window.7Make sure your scanner is selected. If there are multiple scanners on your network, check the "Scanner" section at the top of the window to ensure that the one listed there is the one you want to use.If the
scanner currently selected isn't the one you want to use, click Change... and then select the scanner.8Select a type of document. Click the "Profile" drop-down box, then click one of the following options: 9Select the type of scanner. Click the "Source" drop-down box, then click one of the following options:Feeder - Select this option if your documents
are fed into the scanner through a chute. Used for scanning multiple documents into one PDF.Flatbed - Pick this option if your scanner has a lid that you lift up to place the documents.10Click Scan. It's at the bottom of the window. Doing so will prompt your document to begin scanning into your computer.You can also change color options here
before clicking Scan.11Click File. Once your document finishes scanning, you'll click this tab in the upper-left corner of the window. A drop-down menu will appear.12Click Print. It's in the drop-down menu.13Click Microsoft Print to PDF or Adobe PDF. It's in the large box below "Select Printer."If this isn't an option, use the default settings to scan
your image into your computer as an image, then convert the image to a PDF.14Click Print. This option is in the lower-right side of the window.15Select a save location. Click a folder on the left side of the window.16Enter a name for your PDF. Do this in the field to the right of the "File name" heading.17Click Save. It's at the bottom of the window.
Doing so will save your scanned file as a PDF in your selected save location. Advertisement 1Connect your scanner to your computer. Depending on your scanner, you can do this via the USB cable, or you can connect wirelessly using your home Wi-Fi if your scanner has that feature.Every scanner is different, so consult the manufacturer's user guide
for instructions on how to properly connect your scanner to your computer.2Insert the first page of your document. If you have a flatbed scanner, lift up the lid and place the document face down on the glass top of the scanner. Make sure the document is lined up with any alignment markings on the scanner. If your scanner has an automatic
document feeder, place the document face up in the tray.3Click the Apple menu . It's the Apple logo icon in the upper-left corner of your desktop. This displays the Apple menu.4Click System Settings. It's in the Apple menu. On older versions, this will be System Preferences.5Click Printers & Scanners. It has an icon that resembles a printer.6Select
your scanner and click Open Scanner. The list to the left lists all printers and scanners that have ever been connected to your computer. Click your current scanner model to select it.Printers and scanners that have a red dot next to them and say "Offline" are not available for use. If you see this next to your scanner, make sure it is powered on and
connected to your computer.7Select Use Document Feeder. This depends on what type of scanner you are using. If you are using a flatbed scanner, uncheck this option.[2]8Click Show Details. It's the second button in the lower-right corner. This displays all scanner options.9Select your paper size. If the checkbox next to "Use custom size" is checked,
uncheck it and then use the drop-down menu next to "Size" to select your paper size. US Letter (8.5" x 11") is the most common size.10Select where you want to save the document to. Use the drop-down menu next to "Scan to" to select where to save the document to. By default, scanned documents and images are saved to your "Pictures" folder. You
can select your "Documents" folder, or save it to your Desktop so that you can easily find it.11Select "PDF" as the format. Use the drop-down menu next to "Format" to select "PDF."12Click the checkbox next to "Combine into single document" (if scanning multiple pages). If you are scanning multiple pages, be sure to click the checkbox next to
"Combine into single document." This ensures that all your pages are saved to the same file.13Click Scan. This scans the first page of your document.14Insert the second page in the scanner. If you are using a flatbed scanner, place the second page of the document face down on the glass surface of the scanner. If you are using an automatic document
feeder, place all pages of the document feeder in the tray.If you do not have a scanner that is capable of scanning both sides of the page, you will need to turn the page over and reinsert it in the scanner to scan both sides of the page.15Click Scan. This scans the second page of your document. Repeat for as many pages as you need to scan. When you
are finished, your document will be saved to the location you selected. Advertisement 10pen the PNG to PDF website. Go to in your computer's web browser. If you weren't able to scan a document directly into a PDF, this website will allow you to turn a scanned image (e.g., a PNQG) file into a PDF.If you scanned your document into your computer as a
JPG file, go to instead.2Click UPLOAD FILES. It's in the middle of the page. Doing so opens a File Explorer (Windows) or Finder (Mac) window.3Select your scanned image. Go to the folder in which your scanned image was saved, then click the image to select it.4Click Open. It's in the bottom-right corner of the window. This will upload the image to
the PNG (or JPG) to PDF site.5Wait for your image to convert into a PDF. This should only take a few seconds.6Click DOWNLOAD. It's below your converted file in the middle of the window. Doing so will prompt your PDF to download onto your computer. Advertisement Add New Question Question How do I identify a PDF once it's scanned? When you
save your PDF, you can select the destination of where it saves to, like the desktop or your downloads folder. You can also rename a PDF after it has been scanned. Question I have a folder of 50 pages (files) that I wish to scan into PDFs. How can I save this folder with each page having its own file identifier rather than as one PDF file with 50 pages?
First, save all the pages as a PDF in one large document. Then, go to "Tools," open "Organize Pages," and select "Extract." You can then select "Extract pages as separate files." Each page can then be renamed and saved to any destination. Question After saving the scanned document, how do I trace it and attach it to email? When you scan your
documents, they usually go into a 'scanned documents' folder. So to attach it to an email, just click on attach and then in Documents you just find that document and attach it. See more answers Ask a Question Advertisement Thanks Advertisement Thanks Advertisement Written by: wikiHow Technology Writer This article was co-authored by wikiHow
staff writer, Rain Kengly. Rain is a tech writer and editor for wikiHow with over 5 years of professional writing experience. In the past, Rain has worked with other creative writers as a Writing Tutor at San Francisco State University and has published gaming features, guides, and news articles for a variety of media outlets. Rain shares a lifelong
passion for writing and gaming and is eager to grow alongside new tech inventions. This article has been viewed 1,602,265 times. Co-authors: 23 Updated: September 25, 2024 Views:1,602,265 Categories: Computer Peripherals | Converting PDF Documents PrintSend fan mail to authors Thanks to all authors for creating a page that has been read
1,602,265 times. Portable document format (PDF) displays documents on any device irrespective of the operating system, hardware or software. It displays the same content and allows the integration of different types of content like videos, texts, graphics, animations, audio files, images and more. PDF files are compact, shareable, searchable and
ready to go for users on all platforms. Converting a scanned document into PDF adds security and value to your document. As PDF presents in the same way across all devices, it is a very convenient format for capturing and sending electronic documents. Today, businesses rely on document scanning services to turn large volumes of scanned
documents into customizable PDF files. Lets take a look at the steps involved in converting a scanned document into PDF using different software tools.Tools to Convert Scanned Documents into PDF FormatHere are 10 popular Scan to PDF software tools:Free Scan to PDF: It has a set of standard features like cropping, rotating, page adjustment and
copying.Advanced Scan to PDF Free: It allows for modifying the PDF file in multiple ways.Scan2PDF: This free software for Windows-based computers allows merging multiple scans into PDF.NAPS2: Simple and straightforward, this free tool has some useful features.Readiris Pro 16: It allows converting images and documents to a variety of
formats.QuickScan: Allows documents to be scanned quickly and easily on platforms that are Windows-based.PaperScan Scanner Software: This multipurpose scanning software is compatible with most scanners and scanning devices.VueScan: This tool comes with extensive customization options.ScanSpeeder: This option allows scanning multiple
photos at the same time.OmniPage Standard: It has two versions standard and ultimate and offers high accuracy.Converting Scanned Documents into PDF FormatTo convert paper documents to PDF, you need a scanner and a software tool that generates PDFs.Adobe AcrobatConnect your scanner to your computerLoad the paper documents into the
scannerOpen Adobe Acrobat and select File > Create > PDF from ScannerSelect your scanner from the Scanner drop-down listRetain the default scanner settings or choose a new setting and click on Scan.When Acrobat has scanned and read your documents, select Save in the Untitled.PDF tab.In the Save As PDF window, choose the location you
want to store the PDF (My Computer or Document Cloud). If required, choose Compress PDF or Restrict Editing.WindowsDouble click the Word document and open it in MS Word.Click file on the top left corner of the Word window that opens a pop-out window.Click Export which is on the left side of options. It gives new options in the middle of the
window.Click on create PDF/XPS document which is in the upper left corner of the window.Click on create PDF/XPS.Select a folder where you want to save the PDF.Finally click Publish which is in the bottomright corner that will create a PDF copy of the document.Using MacConnect the computer and scanner. Depending on your scanner, you can
either use the USB cord or, if your scanner has one, connect wirelessly using your home Wi-Fi.Insert your documents first page. If you have a flatbed scanner, place the paper face down on the glass top of the scanner, after lifting the lid. Verify that the document is aligned with the scanners alignment markers.Select the Apple menu. In the top-left
corner of your desktop is the Apple logo symbol. This brings up the Apple menu.Select System Settings and choose Scanners & Printers. Click Open Scanner. All of the printers and scanners that have ever been attached to your computer will be displayed on the left. Choose your current scanner model and click on it.Choose Use Document Feeder.
Choose Show Details, then decide the size of your paper.Click scan after choosing where to save the document.Using SmallPDFOpen SmallPDFs Word-to-PDF in your web browser.Click choose file found in the middle of the SmallPDF page that opens either a file explorer or a finder window.Go to the Word document and select it.Click open at the
bottom right corner of the window. It will upload the Word document to SmallPDF.Click download file the time taken to download the file will depend on the speed of your internet connection.Using AndroidOn your Android device, launch the Google Drive app. To use Google Drive, you must sign into your Google account.Press . It is located in the
screens lower-right corner and it will open a pop-up menu.Press Scan. The pop-up menu contains a camera-shaped icon.Focus the camera on a document on your phone. The center of the screen should include the document. Before continuing, make sure your paper is flat and fully visible.Click OK after tapping the Capture button.Your photo will be
automatically scanned by Google Drive.In the lower-right corner of the screen, tap Save. Your scan will be saved as a result.Save the scanned document to your mobile device. In the upper-right corner, hit the three dots icon and then click Download The Benefits of Converting Scanned Documents into PDF FormatUniversal compatibility: It refers to
the ability of PDFs to be opened on nearly any device while preserving its formatting and layout across various operating systems and platforms.Compact and Effective: High-quality papers can be compressed into smaller file sizes using PDF files, which facilitates sharing and storing.Enhanced Security: To protect sensitive data, PDFs enable
enhanced security features including digital signatures, encryption, and password protection.Accessibility and Searchability: OCR technology makes scanned PDFs searchable, which facilitates information retrieval and discovery.Editing and Integration: PDFs include editing features for more customization and make it simple to integrate different
kinds of content (text, graphics, hyperlinks).Due to these characteristics, PDFs are a very flexible and dependable option for maintaining and digitizing documents for both personal and business use. Why Outsource Document Scanning and Conversion?Professional approach: A document scanning company has a professional team to handle scanning
and converting documents.Saves time: Your staff will have more time to focus on core tasks.Accuracy: Reputable business process outsourcing companies use top quality equipment and software to ensure high quality solutions.Saves infrastructural expenses: Outsourcing saves money as you dont have to hire additional staff or rent more office
space.No hidden charges: A reliable document scanning company will provide the estimated cost of the project before signing the contract. There will be no unexpected charges or expenses.PDF files can be protected with passwords, watermarks and editing permissions. This will ensure that sensitive content, copyright content, and intellectual
property is protected from unauthorized access. Document scanning services can streamline the process of converting physical documents to digital PDF format. These services offer reliable and efficient solutions, saving you time and enhancing accessibility, ensuring your important documents are preserved, organized, and secure.Transform your
physical documents into secure, accessible PDFs effortlessly. Contact us Today! Download Article Learn how to scan your old photographic slides so you can share them online Download Article Back in the days before digital photography was the norm, there were generally 2 methods of processing film: prints, and slides. Prints were developed on a
sheet of photo paper, while slides were small, transparent pieces of film in a cardboard sandwich. With the advent of scanners, prints easily made the transition to digital. Slides, on the other hand, are more problematic, and don't readily take to the scanner. We'll show you how to overcome that limitation, digitize your slides, and bring your slide show
into the 21st century! Use a professional slide digitizing service for a quick and easy solution.Buy a specialized slide scanner to scan slides at home.Project the slide onto a screen and take a photo of it with a digital camera.1Let your fingers do the walking. Go to Google.com, and search for "digitize slides." There are a number business that will be
happy to do the work for you. If you have a lot of slides, the beauty of a professional slide digitizing house is that they can process them much quicker and generally better than you will be able to on your own. Here are some key points to consider:Price. This can vary dramatically, from $50 for 400 slides, to nearly $100 for 250 slides. Considering the
cost of home alternativesand considering how often you'll be shooting slides in the futurethese prices are very reasonable.Delivery. How fast can they turn the job around? Some places will take a couple weeks, others just a couple days, and that may come at a premium. If you want better quality, you can make less of a dent in your wallet if you can
afford to wait.Quality. Slide-scanning services can deliver very high quality scans of your slides that will look good even when printed on 8x10 paper. Make sure they have the technology to reduce or remove dust spots, which is very important with these old slides. Advertisement 1Do it yourself. While scanning companies can generally deliver better
quality and make what might be a tedious task go much quicker, there is a certain satisfaction in doing it yourself, as well as other reasons:It could be an opportunity to discard slides that should never have been taken, like that accidental shot of your tennis shoes or that "artistic" image of a dog and a fire hydrant.There may be pictures in your slide
collection that you simply don't want to share with total strangers.2Purchase a slide scanner. In the consumer category, these can range from under $50 to over $200, and generally, more money gets you better quality and easier workflow. Look for these features:Speed. Some slide scanners require you to scan to your computer, one at a time. If it
takes 30-60 seconds per slide, plus naming and filing time, it can take a considerable amount of time to process a box of 400 slides. Be prepared to give up a weekend for that. Some of the better slide scanners will scan a slide in just a few seconds, and save it to an SD card. When all your slides are scanned, simply open that card on your desktop, and
drag your photos over.Quality. Check out the megapixel number of the scanner you're interested in. They can range from 5 to 9 megapixels. Bigger is better, as they say: the greater the number of pixels, the larger print you can make from your slide.Compatibility. Make sure that the slide scanner either doesn't require any specific software, or if it
does, that it runs on your computer configuration. You don't want to sit down at your Mac this weekend for a massive scanning session only to realize that your shiny new scanner will only work on Windows. It will likely mean that you get to do yard work instead. And that, as they say, just doesn't scan. Advertisement 1Use what you have. "OK," you
say, "I have a scanner. Can't I just plop my slide onto the scanner bed, and do it that way? Of course, you can: but the problem is that the slides are very small.You can check to see if there is an adapter available as an accessory to allow you to mount your slides into a mount holder and scan using your flatbed. This should provide you an opportunity to
preview and save very easily, if not very quickly. If an adapter is not available you can make one using some household materials (e.g. paper, tape, etc.) see www.abstractconcreteworks.com/essays/scanning/backlighter.html. Scanning on a flatbed has inherent limitations in lighting and resolution, and will not generally give you a similar quality image
to a digital photograph nor a professionally scanned slide. 1Shoot it again, Sam. Set up your projector, screen, and tripod and digitally photograph your image as it is displayed on the screen. If there is a manual focus on your camera, use it to adjust for the distance to ensure the image is as sharp as possible.If your camera permits, try bracketing your
image exposure with slower and faster shutter times and a fixed f-stop, and then compositing the picture with image software such as Photoshop. The resolution will still be compromised, but you may have better dynamic range.2Using a slide viewer. Either zoom in or use the macro function of your digital camera to take a picture of the back-lit slide.
The peripheral light present around the slide itself may need to be blocked/blacked out. Use some cardstock or paper and place it so that only the slide's image has any visible light behind it. This process typically requires a tripod to make a sharp image.3Use a stand. If your lens permits you to focus within an inch of the lens, use a stand to take a
close-up image of the slide. Capture is quick with a click of the camera's shutter. You can test your camera for slide, negative copying at www.shotcopy.com/compatibility.htm and build your own copy stand if you choose. Advertisement Add New Question Question Can I scan and make my old slides high-quality? Joo Homem Film & Media Industry
ExpertJoo Homem is a Professional Colorist and Film & Media Industry Expert based in Vancouver, British Columbia. As the Co-Founder and Creative Director of Escuro Studios, a Canadian full-service production company, he oversees creative development and both pre- and post-production for diverse projects, including music videos, commercials,
films, and TV series. He is also the CEO and founder of Cromatic Elements, an online asset store for filmmakers that supports emerging professionals by providing a platform to share high-quality tools, insights, and assets across multiple creative fields. Originally created to develop filmic assets for personal use, Cromatic has grown into a community-
driven space where up-and-coming creatives can access resources designed by top industry professionals. Joos commitment to fostering a collaborative environment and offering accessible, authentic tools has positioned Cromatic as a valuable resource for filmmakers around the world. You can, but if your slide is damaged or faded, this might be a
challenge. There are paid scanning softwares that have tools to restore color, remove scratches, or reduce grain. But remember to use these tools sparingly to avoid overediting and losing the slides original details. For a high-quality scan, scan at a high DPI setting of around 2400 DPI to capture more detail. But as I've mentioned, heavily damaged
slides may not produce perfect results. If a certain slide has an issue like heavy discoloration or scratches, you can use post-scan editing softwares like Photoshop to help restore and enhance your image further. Question Does the slide image come up as a negative after scanning in a film scanner? Usually no. The film is scanned and the image is
color-corrected to produce a positive image, rendering color correctly. When scanning, it can be configured to get the negative or the color inverted one. The film is negative unless it's a "positive film" or slide. Most programs used in film scanners are able to change from one to the other, or they treat all of them as negative films. Question Can I scan
a slide and save to a folder on my desktop? Yes, you can. See the software configuration and the manual of the computer to learn how to create a folder, and how to set a folder as the target for new files for your program. Ask a Question Advertisement Thanks Thanks Thanks Advertisement Thanks Advertisement LJWorld.comPopular Photography Co-
authored by: Film & Media Industry Expert This article was co-authored by Joo Homem. Joo Homem is a Professional Colorist and Film & Media Industry Expert based in Vancouver, British Columbia. As the Co-Founder and Creative Director of Escuro Studios, a Canadian full-service production company, he oversees creative development and both
pre- and post-production for diverse projects, including music videos, commercials, films, and TV series. He is also the CEO and founder of Cromatic Elements, an online asset store for filmmakers that supports emerging professionals by providing a platform to share high-quality tools, insights, and assets across multiple creative fields. Originally
created to develop filmic assets for personal use, Cromatic has grown into a community-driven space where up-and-coming creatives can access resources designed by top industry professionals. Joos commitment to fostering a collaborative environment and offering accessible, authentic tools has positioned Cromatic as a valuable resource for
filmmakers around the world. This article has been viewed 511,834 times. Co-authors: 26 Updated: April 25, 2025 Views:511,834 Categories: Computer Peripherals | Film Cameras PrintSend fan mail to authors Thanks to all authors for creating a page that has been read 511,834 times. "I'm old. I'm tired. I opted for the simple solution." Share your
story 1Make sure the scanner is connected to your computer. To ensure that you can scan your book and save it as a PDF, you will need to add the scanner in Windows or macOS. You can do this wirelessly with modern scanners, or with a USB or Thunderbolt cable for all other scanners.If you're using a large office-style scanner/copying
machine/printer, you might be able to start the scan and choose your options from the screen on the device without using software on your computer. On the printer's screen, look for a "Scan to Email," "Scan to USB drive," or "Scan to Network Folder" option, and choose the destination. Many office scanners have a "Book Mode" setting that you can
chose to ensure the scan captures the pages correctly.[10]Once you scanned the book to the PDF format, you can read it in just about any software, including Adobe Acrobat Reader, Mac Preview, Google Drive, Chrome, Microsoft Edge, and more. You can even print it or convert it to other formats, including Microsoft Word.2Install the software for
your scanner (optional). Whether you're using a dedicated book scanner or flatbed scanner, it will typically come with software that you can install on your PC or Mac. The software that comes with your scanner likely has really easy options for scanning and creating a PDF file, so it's worth a try. Head over to the website of the scanner's
manufacturer, search for your model, and find the "Support" or "Downloads" section to see if any software is available.Both Windows and macOS come with built-in scanning software, but your scanner's actual software will have far more features available.3Prepare your book for scanning. If you are going to feed the pages into an automatic sheet-
feed scanner, see this method to learn how to do this safely. If you're using a dedicated book scanner or flatbed scanner, there's no need to take your book apart.40Open your scanning software. If you installed software for your scanner, open that. If not:Windows: Press Windows key + S to open Search, type scan, then click Windows Fax & Scan.Mac:
Click the Apple menu, go to System Preferences > Printers & Scanners, choose your scanner, then click Open Scanner.[11]If the scanner is also a printer, you might have to click Scan before Open Scan is available.5Place your book on or in the scanner. Now, the fun begins.If you're using a flatbed scanner, open the book, and place it face-down on
the glass. Makes sure the edge of the book is aligned to match the guides on the scanner bed. Lower the cover on top of the book gently to blot out as much background light as possible.For a sheet-feed scanner/automatic document feeder, check for any curls, wrinkles, and binding remnants before loading the pages to avoid paper jams.[12] In most
cases, you'll load the pages face-up, though this may vary depending on your scanner. Before scanning the entire book, start with the first few pages so you can make sure you've inserted the pages in the right direction.Some sheet-feed scanners have a "Duplex" button that you'll need to press if you want to scan both sides of the page. Others might
allow you to choose this option in the scanner's software instead. Double-check your scanner's documentation.For all other scanners, follow the instructions for your specific model.6Select the document source. If you're using a sheet-feed or multi-function scanner, you'll typically have to choose Use Document Feeder, Automatic Document Feeder, or
Sheet Feeder as your source.[13]7Select the option to save the scan as a single PDF document. The steps to do this vary by scanner, but you'll typically be able to select the PDF file type from a "Format" or "File type" menu, as well as the option to combine the scans into a single document.[14]Many automatic sheet-feed scanners will automatically
save your scanned document as a PDF, so you might not need to choose this option.[15]8Choose a destination for the PDF file. Look for an option called "Destination," "Save file to," or similar in your scanner software. You'll be able to select a folder on your computer in which the scanner will create the PDF document.[16]9Select the color or original
document type. For most text-heavy books, you'll want to scan in black and white so the text is easy to read. This is also important if you want to be able to select, extract, or edit the text later.If there's a "Book" or "Text" option in your scanning software (or on the scanner itself), that option will scan the pages in black and white.If there are a lot of
images in the book, grayscale or color will ensure you're getting better-quality images. However, scanning in either of these formats will produce a much larger PDF file (especially color).Many scanners have an "Auto" mode that can switch between black-and-white and grayscale automatically as it senses different types of content on the page.If it's
important to scan extremely high-quality images in color or grayscale, you'll should choose a high DPI (resolution) in your scanning preferences.10Click Scan to start the scan. Depending on the type of scanner you're using, you may need to choose this option in your software or on the scanner itself.If you're using a book scanner or flatbed scanner,
wait until the first scan is captured, and then turn the page and initiate the next scan.If you're using a sheet-feed scanner, the automatic document feeder will quickly scan all of the pages without you needing to do anything. However, you'll want to stay near the scanner in case there's a paper jam so you can fix it quickly.11Review the first scan
before continuing. Take a look at the first few pages before you continue scanning the book. Make sure you've properly placed the book on the scanner so the pages are fully captured and the quality is acceptable on your computer.Even if the text appears kind of small in the scan, resist the urge to crop the margins. You can always zoom in on the
PDF when reading the book on a computer. You can even enlarge the text on e-readers like Kindle.12Continue the scan. Once you've confirmed that the first page(s) have scanned to your liking, turn the page and continue scanning. If you're using a book scanner, you can quickly turn the page and the scanner will (usually) automatically detect the
new text and scan it quickly. For a flatbed scanner, you'll need to lift the book from the glass, turn the page, face it flat again, and then scan the next page manually.13Complete the scan. Once the scan is complete, you might need to select View or Preview to see the document before saving it. Other times, you can simply click Close to stop scanning
and automatically save the PDF file to your computer. Advertisement Download Article Turn a paper document into a PDF file Download Article Scanning documents is easier than everyou can even use your iPhone, iPad, or Android instead of a flatbed scanner or all-in-one printer! And if you've already scanned your document in a different format,
we'll show you how to convert it into an easy-to-send PDF. This wikiHow article will teach you the best ways to scan documents into PDF on any computer, phone, or tablet. On iPhones, open a new note in the Notes app. Tap the camera icon and select Scan Documents to start scanning documents.On Android, open Google Drive. Click + and select
Scan to start scanning documents.On Windows, connect your scanner to your PC. Open Windows Fax and Scan and select New Scan.10pen Notes . It has an icon resembling a notepaper sheet with a yellow top. Tap the icon on your Home screen to open Notes.Notes comes pre-installed on your iPhone or iPad. If you have deleted the app, you can
download it again for free from the App Store. 2Tap the new note icon . It's the icon that resembles a pencil and a sheet of paper. It's in the lower-right corner on iPhone and the upper-right corner on iPad. Advertisement 3Tap the camera icon. It's the icon that resembles a camera. You can find this above the keyboard. This displays a menu for the
camera.[1]4Tap Scan Documents. This is the second option.5Hold your iPhone or iPad over the document. Make sure the entire page is in view of your camera. Hold your iPhone or iPad steady and your iPhone or iPad will automatically take a picture of the document page. The page will flash yellow when your iPhone or iPad detects the page.For best
results, make sure you place the paper of your document on a contrasting surface. Place white paper on a dark surface, or dark paper on a light surface.If you are having problems capturing the document in automatic mode, tap Auto in the upper-right corner (iPhone), or Manual on the side (iPad) to switch to manual mode. Then tap the large circle
button to capture an image of the page manually. Tap and drag the four circles around the page to adjust the white outline. Then, tap Keep scan to save the page.6Repeat for all pages. After scanning the first page of your document, place the next page on the surface and hold your iPhone or iPad over the second page to automatically scan the next
page. Repeat for as many pages are necessary.7Tap the preview image in the lower-left corner. It's the thumbnail image of your most recent scan in the lower-left corner. This displays a preview of all your scans.8Tap a page you want to edit (optional). If you want to edit a page, tap the page to display a full-screen preview.9Edit the page (optional).
Tap one of the options at the top or bottom of the screen to edit the page. The options are as follows:Tap Retake or the plus (+) icon to take another image and replace the scan.Tap the icon that resembles a square with an arrow in the upper-right corner to rotate the page.Tap the icon with three circles to select a filter for the page.Tap the icon that
resembles two angles forming a square to crop the page.Tap the trashcan icon to delete the page.Tap Done when you are done editing the page.10Tap the Share icon . It's the icon that resembles a square with an arrow pointing up. It's in the upper-right corner. This opens the Share menu.If you are using an iPad, tap the icon with three dots () in the
upper-right corner instead. Then tap Send a copy.11Tap Save to Files. This allows you to save the scan as a PDF to your iPhone storage or your iCloud Drive.Alternatively, you can tap Email to email the PDF to someone else.12Select a location to save the file to. Tap On my iPhone/iPad or iCloud Drive. Then tap a folder you want to save the scan
to.13Tap Save. This saves the scan as a PDF to the location you selected. Advertisement 10pen the Google Drive app on your Android device. You'll need to log in to your Google account to use Google Drive.If you aren't already on your Google Drive homepage, tap Home in the bottom-left corner to do so now.2Tap . It's in the bottom-right corner of
the screen. A pop-up menu will open.3Tap Scan. This camera-shaped icon is in the pop-up menu.If you're using the camera for the first time, you may receive a pop-up window. Select either While using the app or Only this time.4Point your phone's camera at a document. The document should be centered in the middle of the screen.Make sure that
your document is flat and completely visible before proceeding.5Tap the "Capture" button. It's a blue-and-white circle at the bottom of the screen. This will scan your document.Select Retry if you want to take the photo again. Otherwise, click OK.Google Drive will automatically convert your picture into a scan. If there is white space, it will
automatically locate the borders of your document.6Tap Save. This is in the bottom-right corner of the screen. This will save your scan.To add more pages to the PDF, tap + and then scan another item.7Save your scanned document onto your phone. Tap the three dots icon in the top-right corner, then tap Download.To email the scan, tap Send a copy.



Advertisement 1Download and install Adobe Scan. Adobe Scan is a mobile app for iPhone, iPad, and Android devices that can be used to scan documents into PDF format using your camera. You can download Adobe Scan for free from the Google Play Store on Android or the App Store on iPhone and iPad. Use the following steps to download and
install Adobe Scan:Open the Google Play Store (Android) or the App Store (iPhone and iPad).Tap the Search tab (iPhone and iPad only).Enter "Adobe Scan" in the search bar.Tap Adobe Scan in the search results.Tap GET or Install next to the Adobe Scan icon.20pen Adobe Scan. It has a blue icon with the Adobe logo. Tap the icon on your Home screen
or Apps menu to open Adobe Scan. Alternatively, you can tap Open in the Google Play Store or App Store once the app is finished downloading.3Sign in to Adobe Scan. You can sign in using your Google account, Facebook account, or Apple ID. Tap Sign in with Google, Sign in with Facebook, or Sign in with Apple to sign in with your Google, Facebook,
or Apple account.Alternatively, if you already have an Adobe ID or want to make one, you can tap, Sign in or sign up at the bottom. Either sign up for a new Adobe ID using your email address or sign in with your existing Adobe ID username and password.4Allow Adobe Scan to access your camera and send notifications. To do so, tap Allow or Ok when
prompted.5Take a picture of the document. To do so, hold your phone or tablet above the document you want to scan and tap the capture button. It's the large circular button at the bottom of the screen.6Tap Keep Scanning. This saves the page you just scanned and allows you to scan the next page.If you're not happy with how the image looks, you
can tap Retake and take the picture again. Alternatively, you can tap and drag the blue circular handles in the corners of the document to adjust the blue outline around the document. Then tap Adjust and save.7Take a picture of the next page. Just like you did with the first page, hold your phone or tablet over the next page of your document and
press the capture button at the bottom of the screen. Repeat for as many pages as your document contains.Retake images or adjust the blue outline around the documents as needed.8Tap the image thumbnail. Once you've taken a picture of your document, you will see a small thumbnail image of the picture in the lower-right corner. Tap this image to
display the scanned document. The scanned document should display just the pages without any of the background or table the document was sitting on.If you want to delete any pages, tap and hold the thumbnail icon to display a thumbnail image of all the pages. Tap the red "x" icon in the upper-left corner of the image of the page you want to
delete, and then tap Delete.9Add a name for the document. To do so, tap the title at the top of the page. Type a name for the document in the first bar of the pop-up. Then tap the blue button that says Rename.10Make any last-minute adjustments. To do so, tap the page you want to adjust and then use the tools at the bottom of the screen to make
adjustments. The adjustment tools are as follows:Tap Add Page to scan another page for your document.Tap Reorder to change the order of the pages. Then tap and drag the pages to change their order.Tap Crop to adjust the page cropping.Tap Rotate to rotate the page.Tap Filers to change the look of the page. You can select, original color, auto-
color, light text, greyscale, or whiteboard.Tap Cleanup and to try to clean up messy looking parts of the document. Then use yoru finger to color over the areas you want to clean up. Then tap the checkmark icon in the upper-right corner.Tap Resize to change the page size. Then select one of the options at the bottom of the screen.Tap Delete to
remove the page.11Tap Save PDF. It's in the upper-right corner. This saves the PDF to your phone or tablet. You can view the document in Adobe Scan, Adobe Acrobat, your web browser, or any other app that can view PDFs.Alternatively, you can save the document as a JPEG image once you have scanned the document. Tap Save as JPEG once you
finish scanning the document to do so. Advertisement 1Connect your scanner to your computer. Depending on your scanner, you can do this via the USB cable, or you can connect wirelessly over your network if your scanner has that feature.Every scanner is different, so consult the manufacturer's user guide for instructions on how to properly
connect your scanner to your computer.2Place your document in the scanner. If you have a flatbed scanner, lift up the lid and place the document face down on the glass top of the scanner. Make sure the document is lined up with any alignment markings on the scanner. If your scanner has an automatic document feeder, place the document face up
in the tray. 30pen Start . Click the Windows logo in the bottom-left corner of the screen.4Type fax and scan into Start. This will search your computer for the Fax and Scan program.5Click Fax and Scan. It's a printer-shaped icon at the top of the Start window. Doing so will open your PC's Fax and Scan program.6Click New Scan. This button is in the
upper-left side of the Fax and Scan window. Clicking it opens a new window.7Make sure your scanner is selected. If there are multiple scanners on your network, check the "Scanner" section at the top of the window to ensure that the one listed there is the one you want to use.If the scanner currently selected isn't the one you want to use, click
Change... and then select the scanner.8Select a type of document. Click the "Profile" drop-down box, then click one of the following options: 9Select the type of scanner. Click the "Source" drop-down box, then click one of the following options:Feeder - Select this option if your documents are fed into the scanner through a chute. Used for scanning
multiple documents into one PDF.Flatbed - Pick this option if your scanner has a lid that you lift up to place the documents.10Click Scan. It's at the bottom of the window. Doing so will prompt your document to begin scanning into your computer.You can also change color options here before clicking Scan.11Click File. Once your document finishes
scanning, you'll click this tab in the upper-left corner of the window. A drop-down menu will appear.12Click Print. It's in the drop-down menu.13Click Microsoft Print to PDF or Adobe PDF. It's in the large box below "Select Printer."If this isn't an option, use the default settings to scan your image into your computer as an image, then convert the
image to a PDF.14Click Print. This option is in the lower-right side of the window.15Select a save location. Click a folder on the left side of the window.16Enter a name for your PDF. Do this in the field to the right of the "File name" heading.17Click Save. It's at the bottom of the window. Doing so will save your scanned file as a PDF in your selected
save location. Advertisement 1Connect your scanner to your computer. Depending on your scanner, you can do this via the USB cable, or you can connect wirelessly using your home Wi-Fi if your scanner has that feature.Every scanner is different, so consult the manufacturer's user guide for instructions on how to properly connect your scanner to
your computer.2Insert the first page of your document. If you have a flatbed scanner, lift up the lid and place the document face down on the glass top of the scanner. Make sure the document is lined up with any alignment markings on the scanner. If your scanner has an automatic document feeder, place the document face up in the tray.3Click the
Apple menu . It's the Apple logo icon in the upper-left corner of your desktop. This displays the Apple menu.4Click System Settings. It's in the Apple menu. On older versions, this will be System Preferences.5Click Printers & Scanners. It has an icon that resembles a printer.6Select your scanner and click Open Scanner. The list to the left lists all
printers and scanners that have ever been connected to your computer. Click your current scanner model to select it.Printers and scanners that have a red dot next to them and say "Offline" are not available for use. If you see this next to your scanner, make sure it is powered on and connected to your computer.7Select Use Document Feeder. This
depends on what type of scanner you are using. If you are using a flatbed scanner, uncheck this option.[2]8Click Show Details. It's the second button in the lower-right corner. This displays all scanner options.9Select your paper size. If the checkbox next to "Use custom size" is checked, uncheck it and then use the drop-down menu next to "Size" to
select your paper size. US Letter (8.5" x 11") is the most common size.10Select where you want to save the document to. Use the drop-down menu next to "Scan to" to select where to save the document to. By default, scanned documents and images are saved to your "Pictures" folder. You can select your "Documents" folder, or save it to your Desktop
so that you can easily find it.11Select "PDF" as the format. Use the drop-down menu next to "Format" to select "PDF."12Click the checkbox next to "Combine into single document" (if scanning multiple pages). If you are scanning multiple pages, be sure to click the checkbox next to "Combine into single document." This ensures that all your pages are
saved to the same file.13Click Scan. This scans the first page of your document.14Insert the second page in the scanner. If you are using a flatbed scanner, place the second page of the document face down on the glass surface of the scanner. If you are using an automatic document feeder, place all pages of the document feeder in the tray.If you do
not have a scanner that is capable of scanning both sides of the page, you will need to turn the page over and reinsert it in the scanner to scan both sides of the page.15Click Scan. This scans the second page of your document. Repeat for as many pages as you need to scan. When you are finished, your document will be saved to the location you
selected. Advertisement 10pen the PNG to PDF website. Go to in your computer's web browser. If you weren't able to scan a document directly into a PDF, this website will allow you to turn a scanned image (e.g., a PNG) file into a PDF.If you scanned your document into your computer as a JPG file, go to instead.2Click UPLOAD FILES. It's in the
middle of the page. Doing so opens a File Explorer (Windows) or Finder (Mac) window.3Select your scanned image. Go to the folder in which your scanned image was saved, then click the image to select it.4Click Open. It's in the bottom-right corner of the window. This will upload the image to the PNG (or JPG) to PDF site.5Wait for your image to
convert into a PDF. This should only take a few seconds.6Click DOWNLOAD. It's below your converted file in the middle of the window. Doing so will prompt your PDF to download onto your computer. Advertisement Add New Question Question How do I identify a PDF once it's scanned? When you save your PDF, you can select the destination of
where it saves to, like the desktop or your downloads folder. You can also rename a PDF after it has been scanned. Question I have a folder of 50 pages (files) that I wish to scan into PDFs. How can I save this folder with each page having its own file identifier rather than as one PDF file with 50 pages? First, save all the pages as a PDF in one large
document. Then, go to "Tools," open "Organize Pages," and select "Extract." You can then select "Extract pages as separate files." Each page can then be renamed and saved to any destination. Question After saving the scanned document, how do I trace it and attach it to email? When you scan your documents, they usually go into a 'scanned
documents' folder. So to attach it to an email, just click on attach and then in Documents you just find that document and attach it. See more answers Ask a Question Advertisement Thanks Advertisement Thanks Advertisement Written by: wikiHow Technology Writer This article was co-authored by wikiHow staff writer, Rain Kengly. Rain is a tech
writer and editor for wikiHow with over 5 years of professional writing experience. In the past, Rain has worked with other creative writers as a Writing Tutor at San Francisco State University and has published gaming features, guides, and news articles for a variety of media outlets. Rain shares a lifelong passion for writing and gaming and is eager
to grow alongside new tech inventions. This article has been viewed 1,602,265 times. Co-authors: 23 Updated: September 25, 2024 Views:1,602,265 Categories: Computer Peripherals | Converting PDF Documents PrintSend fan mail to authors Thanks to all authors for creating a page that has been read 1,602,265 times. Convert documents and
images to PDF with this free online PDF converter. You can even take a screenshot of a website by providing us the URL and convert HTML to PDF. Upload your document and convert to PDF instantly. Optionally just enter a URL and we will convert the file we find there. The PDF online converter can convert from Microsoft Word to PDF as well as a
lot of other formats. If the PDF contains only scans from text pages, you can convert it to a searchable PDF file using the OCR functionality. If you want more advanced features like rotate, merge or sort PDF pages, you can use this free PDF editor. 1 2Make sure your iPhone is running the latest version of iOS. This ensures that your iPhone can
connect to iTunes. To update your iPhone, see Update iOS. Advertisement 3Connect your iPhone to the computer with a USB cable. Use the cable that came with your iPhone or one thats compatible. When the iPhone is connected, its icon will appear at the top-left corner of iTunes.If iTunes did not open automatically, click its icon in the Dock
(macOS) or in the All Apps area of the Start menu (Windows).4Click the iPhone icon. Its at the top-left corner of iTunes. This opens the Summary screen.5Click File Sharing. Its in the left column of iTunes, under Settings. All apps with file-sharing features will appear in the right panel.6Share files from the computer to the iPhone. You can skip this
step if you only want to share files from the iPhone to the computer. Heres how to get files that are on your PC or Mac to the iPhone:Click the app in the right panel you want to share with. For example, if youre sharing an Excel file, click the Excel icon.Click Add File in the right panel to open your computers file browser.Browse to the file you want to
share to the iPhone.Select the file and click Open to add it to the list of files for that app.7Share files from the iPhone to the computer. Skip this step if you only want to share files from the computer to the iPhone. Heres how to get files to the computer from the iPhone:Click the app in the right panel that contains the file you want to share.Select the
file.Click Save to in the right panel to open your computers file browser.Click the folder on your computer where you want to save the file.Click Select Folder. The file is now accessible on your computer. Advertisement 10pen the Files app on your iPhone. Its the blue folder icon thats typically found on the home screen.2Tap iCloud Drive. Its the
option with a light blue cloud icon under Locations. This opens the directory of your iCloud Drive.3Browse to the folder with the file(s) you want to share. A list of files will appear.4Tap Select. Its at the top-right corner of the screen.5Tap each file you want to share. This adds a check mark to the left of each file name.6Tap . Its at the bottom-left corner
of the screen. A list of sharing methods will appear.7Tap Add People. Its the outline of a persons head and a plus sign in the bottom row of icons.8Tap Share Options. Its at the bottom of the screen.9Choose who can access the file.Under Who Can Access, select Only people you invite to share with certain people. If you want anyone who has the link to
be able to view the file, select Anyone with the link instead.Under Permission, choose whether people with access to the file Can make changes or can View only.Tap the back button to return to the Add People screen.10Select an app to use for sharing the file. The app you select will open to a new message or post with the file (or a link)
attached.11Enter the recipient(s). The steps will vary by app, but you can choose from a list of contacts, enter an email address (if using Mail) or a phone number (if using Messages).12Enter a message. If youd like, enter a message that describes the file and/or why youre sharing it.13Send or post the message. This sends a message to the recipient
with the file (or link) attached. Advertisement Ask a Question Advertisement Written by: wikiHow Technology Writer This article was co-authored by wikiHow staff writer, Nicole Levine, MFA. Nicole Levine is a Technology Writer and Editor for wikiHow. She has more than 20 years of experience creating technical documentation and leading support
teams at major web hosting and software companies. Nicole also holds an MFA in Creative Writing from Portland State University and teaches composition, fiction-writing, and zine-making at various institutions. This article has been viewed 60,887 times. Co-authors: 4 Updated: February 24, 2025 Views:60,887 Categories: I[Phone PrintSend fan mail
to authors Thanks to all authors for creating a page that has been read 60,887 times. Remove the inside of a metal pen and fill the tip with cotton to make a quick stylus.Use a cotton swab as a makeshift stylus. You can also cut the tip of the swab off and insert it into a pen tip.If you use a metal pen and want to protect your screen, wrap the gap
between the pen and the cotton in aluminum foil.1Remove the ink tube from a pen that has a metallic body. Unscrew the mouth of the pen to reveal the ink tube. Pull out the ink tube and the spring from the body of the pen and then screw the pen back together. Throw the ink tube straight into the trash once you remove it to stop it from leaking on
your furniture.[1]It is important to use a pen with a metallic body, as this conducts the electrical charge from your hand which makes the stylus to work. 2Push a little cotton ball into the tip of the pen. The cotton ball helps to conduct the electrical current and gives the stylus a padded pointer. Roll up a little cotton ball and push it into the nib of the
pen. Try to push as much of the cotton ball as you can into the pen so that it doesn't come loose when you try to use the stylus. [2]If you don't have a cotton ball, use a small piece of cotton fabric. Advertisement 3Trim off any excess cotton ball that is hanging out of the nib. This makes the stylus easier to use and makes its touch more accurate. Leave
about 2 millimetres (0.079in) of the cotton ball hanging out of the pen so that the tip of the metal pen doesn't scratch your screen.[3]If the cotton ball falls out or gets pushed into the pen over time, simply push a little more of the cotton ball into the nib of the pen.4Use your pen stylus in the same way that you would use your finger. Press the cotton
ball down on the screen to activate it. Move the stylus around the screen to navigate around the device. Keep spare cotton balls on hand to refill your stylus in case it falls out with usage or in storage.[4] Advertisement 1Unscrew the pen to remove the ink tube. In order to make this stylus, you need a pen that can be unscrewed. Remove the spring and
ink tube from inside the pen and then reassemble the pen.[5]Keep the small inside parts of the pen away from children, as they can pose a choking risk.2Cut the middle of a cotton swab on an angle. Estimate where the middle of the cotton swab is and then chop it in half on a sharp angle. This creates a pointy end on the plastic part of the cotton swab
which makes it easier to insert into the pen.[6]Throw 1 half of the cotton swab into the trash, as it is not needed for the stylus.3Poke the pointy end of the cotton swab into the tip of the pen. Leave the cotton portion of the cotton swab and about 5 millimetres (0.20in) of the plastic handle out of the pen. Don't worry if the cotton swab is a little loose,
simply hold it in place for now.[7]4Secure the cotton swab in place with a piece of tape. Wrap the tape around the plastic portion of the cotton swab and the mouth of the pen so that it stays in place when you are using your stylus. If the cotton swab still feels a little loOse, simply wrap another piece of tape around it.[8]Both sticky tape and masking
tape work for this task. Avoid using washi tape, as this doesn't tend to be as sticky.5Wrap a 9cm (3.5in) square of foil around the cotton swab and the neck of the pen. Cut out the aluminium foil with a pair of scissors. Wrap the square tightly around the plastic portion of the cotton swab and around the neck of the pen. The aluminium foil helps to
transfer the electrical current from your hand to the tip of the cotton swab.[9]Don't cover up the cotton portion of the cotton swab, as this helps to prevent the screen from getting scratched.6Moisten the tip of cotton swab with water each time you use it. Wet your fingers and then dab the cotton swab with your damp fingers. This small amount of
water helps to conduct the electrical current and makes the point of the stylus more accurate. Use your homemade stylus to navigate your way around your device. If it loses its accuracy, simply place a little extra water on the end of the cotton swab.[10]Avoid soaking the cotton swab in water, as this can leave drops of water on your screen.
Advertisement Add New Question Question I put water on the end of my stylus and use it on my phone screen, but nothing happens. Please help. Make sure that the foil is in contact with the tip, and that you are touching the foil at all times. Remember, it's your body's natural electric field that allows you to interact with your tablet screen, and that
the foil and wet tip are conducting that field. Question Is it important to use only cotton swabs or we can use cotton? You can use cotton balls if you would rather, they'll work just as well. Question Can I use a pencil as a stylus? No. The eraser is far too rough for the screen and will just dirty it up. The graphite tip will just destroy the screen. See more
answers Ask a Question Advertisement ScissorsCotton ballPen with a metallic bodyScissorsCotton swabSticky tapeWaterAluminium Foil This article was co-authored by wikiHow Staff. Our trained team of editors and researchers validate articles for accuracy and comprehensiveness. wikiHow's Content Management Team carefully monitors the work
from our editorial staff to ensure that each article is backed by trusted research and meets our high quality standards. This article has been viewed 269,280 times. Co-authors: 18 Updated: February 8, 2025 Views:269,280 Categories: Featured Articles | Nintendo DS | Computer Peripherals PrintSend fan mail to authors Thanks to all authors for
creating a page that has been read 269,280 times. Any scanned document can be converted into different formats, including PDF. By converting ascanned document to PDF, you can edit and make change to your important scanned documents. This article will show you how to scan documents to PDF and convert scanned documents to editable PDF
with Wondershare PDFelement - PDF EditorWondershare PDFelementWondershare PDFelement and more.This makes it easier to make modifications to a scanned document and save it into many output formats such as editable PDF, Word, Excel, PPT, EPUB, etc. Part 1. How to Convert a Scanned Document to PDFLearn how to convert and edit a
scanned document as a PDF file. Follow the steps below after you've ensured you downloaded and installed OCR.Step 1. Import Scanned Document into PDFelementRun PDFelement on your computer. The file can be opened directly with PDFelement by clicking on the add button.Step 2. Convert Scanned Document to PDFUsing the OCR function, the
program will automatically detect the scanned file and then prompt you to use OCR. Click on the "Perform OCR" button from the top information bar and select the language of the document. You can then click "OK". While OCR is being performed, don't try to perform any other activities.Step 3. Edit Content in Your PDF (Optional)After the OCR is
complete, you can further edit your document if necessary. PDFelement offers a variety of editing and annotation tools. To modify the text in your document, you can go to the "Edit" tab and choose edit mode. Then click on the text that you want to edit and make the change.Step 4. Save Your File as PDFIf you're satisfied with the changes you've
made, you can now save the scanned document as a PDF. Use the "Save" icon in the upper menu bar or you can go to "File > Save as". You will be able to choose where to save the file and the file name.PDFelement offers fast recognition of text, images, and numbers, and effectively keeps document layout intact. It also supports a wide range of OCR
languages, enabling you to get an editable file with high accuracy. Video Solution - How to Convert Scanned Document to PDFTo make you know how to convert scanned documents to PDF more directly and comprehensively, you can view this video and explore more videos about PDFelement from Wondershare Video Community. G2 Rating: 4.5/5
[100% Secure Part 2. How to Convert a Scanned Document to PDF - PDF Converter ProWondershare PDF Converter Pro is another powerful PDF converter which can not only help you convert scanned document to PDF but can also help you convert PDF to other Microsoft Office format. Here, you will be guided on the easiest way to convert scanned
documents to PDF. Step 1. Add scanned documentLaunch Wondershare PDF Converter Pro, go to the "OCR" tab, then click the "Add" button to add a scanned document into this PDF converter.Step 2. Convert scanned document to PDFAfter uploading your scanned document, choose "PDF" under the "Format" drop-down menu, then go to "OCR
Setting" to choose the language you need to recognize. Click the "SUBMIT" icon then click the "Convert" button, the OCR process will be finished in seconds. Then you will get the converted PDF file. How to Convert a Scanned Document to PDF - HiPDFThere is another method to convert scanned documents into PDF. HiPDF is one of the best online
PDF converters, it can not only convert PDF to Microsoft Office format but also encrypt PDF, compress PDF, crop PDF, etc. Now, follow the steps below to learn how to convert scanned documents to PDF.Step 1. Upload Scanned DocumentWhen you open the HiPDF website, click the "Convert" option on the top toolbar, and select "Image to PDF."
After selecting the "Image to PDF" option, you will open a new web page that allows you to upload the scanned document. Click the "Select File" button and then open the scanned document. In addition, you can upload files by dragging them to the web page.Step 2. Convert scanned document to PDFAfter uploading the scanned document, click the
"CONVERT" button. In only a few seconds, the scanned document will be converted to a PDF file and you can click "DOWNLOAD" to save your file. Tips for How to Convert Scanned Document to PDF using OCRThere are more than twenty languages that you can select from. This will ensure that you won't have issues with the recognition of special
characters in your document.If you have a larger document with hundreds of pages, you can customize the page range as you wish.After you access the OCR feature, you are able to select multiple options such as how your document should be displayed, the zoom view for your document, and the default font for a text box.You can convert your files
from multiple formats such as image, Word, Excel, PowerPoint, EPUB, HTML, into PDF and vice versa, from PDF to many other formats. Free Download or Buy PDFelement right now! Free Download or Buy PDFelement right now! Try for Free right now! Try for Free right now! Download Article Quickly connect your scanner and computer wirelessly
or with a cable Download Article If you need to set up your computer to scan documents or photos, you can do so in a few simple steps. You can connect your scanner to your Windows or Mac computer by the USB cable, or if it's supported, you can link your scanner and use it wirelessly using Wi-Fi or Bluetooth. This wikiHow article will show you how
to add your scanner to your Windows or Mac computer wirelessly or with a wired USB cable and how to troubleshoot connection issues. On Windows, connect your scanner. Open "Settings" "Devices" "Printers & Scanners" "Add a printer or scanner".On Mac, connect your scanner. Click the Apple logo "System Preferences" "Printers & Scanners" "+"
Add your scanner.Your scanner and computer must be on the same Wi-Fi network.1Plug in your scanner to a power source and turn it on. You need it powered on so your computer can detect it. 2Connect your scanner to your computer with a USB cable. Using the USB cable that came with your scanner, plug it into an open USB port on your
computer. If you don't have a USB cable that came with your scanner, usually any USB cable will work.[1]If your computer detects the scanner once they are both powered on, you need to follow the on-screen prompts to download any necessary drivers and skip the rest of this method. Advertisement 30pen your Windows Settings. You can do so on
Windows 10 and 11 by clicking the Start menu and selecting Settings or the gear icon.[2]4Click Devices (Windows 10) or Bluetooth & devices (Windows 11). On Windows 10, you'll see this with an icon of a speaker and keyboard in the second column. On Windows 11, you'll see it in the left panel.[3]5Click Printers & Scanners. You'll see this in the
vertical menu on the left side of the window.[4]6Click Add a printer or scanner. You'll see this at the top of the window.7Click your scanner's name and click Add device. In the list that populates, the scanner you want to add will most likely display with the manufacturer name, the model name, and/or the model number.[5]Follow any on-screen
instructions if any pop-up. For instance, if your Windows Security asks for permission to allow your scanner to install software and drivers, click Yes. Advertisement 1Plug in your scanner to a power source and turn it on. You need it powered on so your computer can detect it.2Put your scanner into pairing mode. Some wireless scanners, especially
scanners that use Bluetooth to connect wirelessly, require you to put them in pairing or discovery mode first. Each scanner will vary in this process, but you'll most likely need to press the Bluetooth button on your scanner.If you're unsure if your scanner is in pairing mode or you can't find a Bluetooth button, refer to your device's manual.[6]If your
computer detects the scanner once they are both powered on, you need to follow the on-screen prompts to download any necessary drivers and skip the rest of this method.30pen your Windows Settings. You can do so by clicking the Start menu and selecting Settings or the gear icon.4Click Devices (Windows 10) or Bluetooth & devices (Windows 11).
On Windows 10, you'll see this with an icon of a speaker and keyboard in the second column. On Windows 11, you'll see the Bluetooth icon on the left panel.5Click Printers & Scanners. You'll see this in the vertical menu on the left side of the window on Windows 10, or in the right panel on Windows 11. A list of available scanners will populate.6Click
Add a printer or scanner. You'll see this at the top of the window.Your computer must be on the same Wi-Fi network as your scanner for it to detect it. If you're using Wi-Fi extenders for either device, connecting might not be successful.[7]7Click your scanner's name and click Add device. In the list that populates, the scanner you want to add will most
likely display with the manufacturer name, the model name, and/or the model number.You can now scan documents and scan photos. Advertisement 1Plug in your scanner to a power source and turn it on. You need it powered on so your computer can detect it. 2Click the Apple logo . You'll see this in the menu bar that runs horizontally across the top
of your screen.If you're not using an AirPrint printer/scanner, you'll need to update your printer drivers.Don't install the scanner's software beforehand. MacOS should download the latest scanner software automatically.3Click System Settings. This is generally the second listing in the drop-down menu.4Click Printers & Scanners. You'll see this next
to an icon of a printer in the sidebar.5Click Add Printer, Scanner, or Fax if needed. You'll see this in the bottom left corner of the window.If you see your scanner, skip this step.6Select your scanner. When you click your scanner, your Mac will begin the process of setting up that device so you can easily use it.[9]If you're having issues, make sure to
check for macOS updates.You may need to connect your scanner with a cable first to set up wireless scanning. To do so, proceed to the next method. Advertisement 1Plug in your scanner to a power source and turn it on. You need it powered on so your computer can detect it.2Connect your scanner and computer. Using the USB cable that came with
your scanner, plug it into an open USB port on your computer. If you don't have a USB cable that came with your scanner, usually any USB cable will work.If your Mac only has one USB-C port and you have a USB connection, you can use a multiport adapter.[10]30pen System Settings. Click the Apple logo at the top-left corner of the screen, and
select System Settings (Ventura and later) or System Preferences (Monterey and earlier).[11]4Click Printers & Scanners. You'll see this next to an icon of a printer on Monterey and earlier. If you're using macOS Ventura or later, it'll be in the left sidebar.[12]5Click Add Printer, Scanner, or Fax if needed. If you don't see your scanner listed, click this
option to add it now. If your scanner is listed, you can skip this step.6Select your scanner. When you click your scanner, your Mac will begin the process of setting up that device so you can easily use it.[13]If you're having issues, make sure your macOS is up to date.Your scanner will be ready for use. If you have a printer with a built-in scanner, you
can scan and print photos from your Mac computer. Advertisement 1Download the proper drivers. Input your scanner brand and model into a search engine along with "driver download". Be sure to use the official company website for your scanner.[14]After installing your scanner's drivers, restart your computer.MacOS should automatically install
the latest scanner software. If it doesn't, you'll need to update your software manually.2Restart your computer. In some cases, your computer may need a restart to function properly. Do this after installing any new programs or drivers.On Windows, select Start Power Restart.On Mac, select the Apple menu Restart.3Restart your scanner. Use the
Power button on your scanner to turn off the device. Unplug it from the power for a few minutes, then plug it back in.Refrain from turning off the scanner by unplugging the scanner if you have a Power button. This could interrupt scans in progress and cause your device to slow down.4Connect your scanner via ethernet. Your scanner may have
trouble connecting to your Wi-Fi network. Connecting your scanner to your computer with an ethernet cable can help your computer recognize the device.5Make sure the scanner is within range. If your scanner is too far from your computer or if its signal is blocked, your computer won't be able to recognize it. Try to set up your scanner next to your
computer.6Check firewall and antivirus settings. Your scanner needs permission to communicate with your computer. Be sure your scanner is an allowed program in your firewall and antivirus settings.7Purchase a new scanner. If you're trying to connect an old scanner with a new computer, the software may no longer be compatible. In this case,
you'll need to buy a new scanner. Advertisement Ask a Question Advertisement Thanks Thanks Advertisement Written by: wikiHow Technology Writer This article was co-authored by wikiHow staff writer, Darlene Antonelli, MA. Darlene has been writing and editing tech content at wikiHow since 2019. She previously worked for AppleCare, served as
a writing tutor, volunteered in IT at an animal rescue, and taught as an adjunct professor for EN101 and EN102. Darlene has completed Coursera courses on technology, writing, and language. She holds both a BA (2011) and an MA (2012) from Rowan University in Writing, with a focus on workplace communication. With her extensive experience,
academic background, and ongoing learning, Darlene has become the go-to grammar expert for her friends and family, as well as a skilled wordsmith for anyone in need. This article has been viewed 186,672 times. Co-authors: 4 Updated: March 12, 2025 Views:186,672 Categories: Computers and Electronics PrintSend fan mail to authors Thanks to
all authors for creating a page that has been read 186,672 times. 1Conecta tu escner a la computadora. Segn el tipo de escner que tengas, puedes conectarlo por medio de un cable USB o hacerlo inalmbricamente a travs de tu red, si el escner tiene esa funcin.Todos los escneres son diferentes, as que es mejor que leas la gua de usuario del fabricante
para ver las instrucciones de cmo conectar el tuyo a la computadora en forma correcta. 2Coloca el documento en el escner. Debes colocar el documento que quieras convertir en PDF.3Abre Inicio. Haz clic en el logo de Windows ubicado en la esquina inferior izquierda de la pantalla.4Escribe fax y escner en Inicio. Al hacerlo, se buscar el programa
"Fax y Escner de Windows".5Haz clic en Fax y Escner de Windows. Es un cono en forma de impresora que aparecer en la parte superior de la ventana de Inicio. Al hacer clic, se abrir el programa "Fax y Escner de Windows" en tu computadora.6Haz clic en Nueva digitalizacin. Es un botn que est en la parte superior izquierda de la ventana de "Fax y
Escner de Windows". Al hacer clic, se abrir una nueva ventana.7Asegrate de que tu escner est seleccionado. Si hay varios escneres conectados a tu red, revisa la seccin "Escner" de la parte superior de la ventana para asegurarte que el escner que aparece all sea el que quieras usar.Si el escner que est seleccionado actualmente no es el que quieres
usar, haz clic en Cambiar y seleccinalo.8Selecciona un tipo de documento. Haz clic en el cuadro desplegable "Perfil" y luego en una de las siguientes opciones: 9Elige el tipo de escner. Haz clic en el cuadro desplegable "Origen" y luego en una de las siguientes opciones:Bandeja: elige esta opcin si tus documentos se insertan en el escner a travs de una
bandeja. Esto se utiliza para escanear varios documentos en un solo PDF.Plano: elige esta opcin si tu escner tiene una tapa que se levanta para colocar los documentos.10Haz clic en Digitalizar. Est en la parte inferior de la ventana. Al hacer clic, el documento comenzar a escanearse en tu computadora.Tambin puedes cambiar las opciones de color
antes de hacer clic en Digitalizar.11Haz clic en Archivo. Una vez que tu documento termine de escanearse, debes hacer clic en esta pestaa que est en la esquina superior izquierda de la ventana. Aparecer un men desplegable.12Haz clic en Imprimir. Es un men desplegable.13Haz clic en el cuadro desplegable "Impresora". Lo encontrars en la parte
superior izquierda de la ventana "Imprimir".14Haz clic en Microsoft Print to PDF (imprimir a PDF). Es una de las opciones del men desplegable Impresora.Si no encuentras esa opcin, usa las configuraciones predeterminadas para escanear la imagen en tu computadora como un archivo de imagen, y luego convierte la imagen a PDF.15Haz clic en
Imprimir. Esta opcin se encuentra en la parte inferior derecha de la ventana.16Elige la ubicacin donde quieras guardar el archivo. Haz clic en una carpeta en el lado izquierdo de la ventana.17Escribe un nombre para tu PDF. Escrbelo en el campo que est a la derecha del encabezado "Nombre de archivo".18Haz clic en Guardar. Este botn est en la
parte inferior de la ventana. Al hacer clic, el archivo escaneado se guardar como PDF en la ubicacin que elegiste. Anuncio 1Conecta tu escner a la computadora. Segn el tipo de escner que tengas, puedes conectarlo a travs de un cable USB o hacerlo inalmbricamente con la red wifi de tu casa, si el escner tiene esa funcin.Todos los escneres son
diferentes, as que es mejor que leas la gua de usuario del fabricante para ver las instrucciones de cmo conectar el tuyo a la computadora en forma correcta.2Coloca el documento en el escner. Debes colocar el documento que quieras convertir en PDF.3Haz clic en Ir. Encontrars esta opcin de men en la fila de opciones de la esquina superior izquierda
de la pantalla de tu Mac.Si no ves la opcin Ir, haz clic en el escritorio de tu Mac o abre una nueva ventana de Finder.4Haz clic en Aplicaciones. Est cerca de la parte inferior del men desplegable Ir. Se abrir la carpeta Aplicaciones de Mac.5Haz doble clic en Captura de Imagen. El cono de este programa parece una cmara. Se abrir Captura de
Imagen.Tal vez tengas que desplazarte hacia abajo para encontrar "Captura de Imagen".6Selecciona tu escner. Haz clic en el nombre de tu escner en la parte superior izquierda de la ventana.[1]7Selecciona un tipo de escner. Haz clic en el cuadro desplegable que aparece junto a "Modo" y luego en alguna de las siguientes opciones:Alimentador: elige
esta opcin si tus documentos se insertan en el escner a travs de una bandeja. Esto se utiliza para escanear varios documentos en un solo PDF.Escner plano: elige esta opcin si tu escner tiene una tapa que se levanta para colocar los documentos.8Elige una carpeta de destino. Haz clic en el cuadro desplegable "Escanear a" y luego en la carpeta a donde
quieras enviar el archivo (por ejemplo, el Escritorio).9Haz clic en el cuadro desplegable Formato. Est en el medio del lado derecho de la pgina.10Haz clic en PDF. Esta opcin est en el men desplegable Formato. As, el documento se escanear con formato PDF.Si no encuentras esa opcin, usa las configuraciones predeterminadas para escanear la imagen
en tu computadora como un archivo de imagen, y luego convierte la imagen a PDF.11Haz clic en Escanear. Est en la esquina inferior derecha de la ventana. Al hacer clic en esta opcin, el documento se escanear en tu computadora y se guardar como PDF en la ubicacin que elegiste. Anuncio 1Abre el sitio web de "PNG to PDF". Ve a en un navegador
web de tu computadora. Si no pudiste escanear el documento directamente como PDF, este sitio web te permitir convertir el archivo de una imagen escaneada (por ejemplo, un PNG) en un PDF. 2Haz clic en UPLOAD FILES (subir archivos). Se encuentra en el medio de la pgina. Al hacer clic, se abrir una ventana del Explorador de archivos (Windows)
o de Finder (Mac).3Selecciona la imagen que escaneaste. Ve a la carpeta donde est guardada la imagen escaneada y haz clic en ella para seleccionarla.4Haz clic en Abrir. Est en la esquina inferior derecha de la ventana. Al hacerlo, se subir la imagen al sitio "PNG to PDF" (o "JPG to PDF").5Espera a que la imagen se convierta en PDF. Solo tardar unos
segundos.6Haz clic en DOWNLOAD (descargar). Est debajo del archivo convertido, en el medio de la ventana. Una vez que hagas clic, se descargar el archivo PDF a tu computadora. Anuncio En Windows 7 y versiones anteriores, no siempre se puede escanear directamente en PDF. Si no puedes hacerlo, la mejor opcin es utilizar las configuraciones
predeterminadas de escaneo y convertir la imagen en PDF. Anuncio wikiHow es un "wiki", lo que significa que muchos de nuestros artculos estn escritos por varios autores. Para crear este artculo, autores voluntarios han trabajado para editarlo y mejorarlo con el tiempo. Este artculo ha sido visto 68508 veces. Categoras: Manipulacin de archivos Esta
pgina ha recibido 68508 visitas.
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